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1. INTRODUCTION

We are going to introduce RRRSDP Webmail services for RRRSDP users for viewing of
mails using web browser. This will enable the RRRSDP users to view their e-mails from
anywhere in world through internet. Webmail services will be available to the users via

the URL http://www.rrr.gov.np/webmail or by clickihng RRRSDP Web Mail at the
RRRSDP's website http://www.rrr.gov.np

2. WEBMAIL TERMINOLOGY
POP3 - 'Post Office Protocol' (Version 3):

The most popular way for users to access their email is through the POP3
protocol. When a user checks for new email messages using POP3, the messages
are downloaded to the user's local computer and into the email client of their choice.
Then, in most cases, the messages are removed from the mail server. This method is
well-suited for users who have limited storage space on their email provider's mail
servers or those who don't want to store email messages online.

Most email clients, like Microsoft Outlook and Mozilla Thunderbird, allow users to leave
email messages on their email provider's mail servers, even after the messages
have been downloaded to the user's local computer. For users who want to
download their messages to their local computer, but also want to access their
messages online via webmail, this option provides the most flexibility.

IMAP4 - 'Internet Message Access Protocol' (Version 4):

IMAP is another popular protocol for accessing email messages. With IMAP, instead of
downloading new messages to the user's local computer, the messages continue
to be stored on the mail server. When users access their email through an email
client such as Microsoft Outlook, Netscape Mail or Mozilla Thunderbird, they are
working directly with the messages stored on their mail server. For example, when
an IMAP user composes and sends a new email message, that message will be
stored in the Sent folder, which is stored on the mail server.

IMAP is a convenient option for users who need to access their email online from
multiple computers and locations—but prefer to use email client software instead of
webmail. Because all messages—including sent messages, drafts, and messages
stored in mail folders—are stored on the mail server, they are accessible from any
Internet-enabled computer with pre-configured email client software. IMAP can also
be useful for wireless email users who need access to their email with their wireless
device, but do not want to overload their device's memory by downloading and
storing messages locally.
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SMTP (Simple Mail Transfer Protocol)

SMTP is the standard that defines how email messages are sent from a mail
server. To help prevent the growing proliferation of spam, which is often routed
through unprotected or "Open Relay" servers, many service providers now require
SMTP Authentication. SMTP Authentication allows users to send email only if their
mailbox belongs to the service provider's system. SMTP can be defined also as it is a
method for sending email messages between servers. Most email systems that send
mail over the Internet use SMTP to send messages from one server to another; the
messages can then be retrieved with an email client using either POP or IMAP.

Password:

A Password is a secret word or code, which a user must supply during a Login to
demonstrate that he is, in fact, the person he claims to be. It is one-half of a
typical set of Credentials used in Authentication.

Web
Short for "World Wide Web."
Web page

A document designed for viewing in a web browser typically written in HTML. A web site
is made of one or more web pages

HTTP - 'Hyper Text Transfer Protocol':

The protocol for moving hyper text files across the Internet. Requires a HTTP client
program on one end, and an HTTP server program (such as Apache) on the other end.
HTTP is the most important protocol used in the World Wide Web (WWW).

3. Basic Guideline for Usage:

Tour of RRRSDP Webmail:

1. Login Form:

Steps:

1. Enter/Type:  http://www.rrr.gov.np in Internet Explorer or any Web Browser.
2. Click on Web Mail Icon on RRRSDP's Website (above icon)
3. Input your user name and password given by RRRSDP’s PCU
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2. Password Change Form:

You can change your password as per your requirement. To change password the
initial login is required.

Click to open Windows Mail (in Windows Vista) or Outlook Express (in Windows XP)

1. Click the Tools menu, and then click Accounts.
2. Click the account you want to change the password for, and then click Properties.
i: rrr.gov.np Properties @

General | Servers |Ennnectinn | Securty | Pud\ranc:edl

Server Information

My incorming mail server is a POP3 SETMVET.
Incoming mail (POP3):  rrr.gov.np

Outgeing mail (SMTP):  smtp.fol.com.np

Incoming Mail Server

E-rnail username: skarki@rrr.gov.np
Passward: EBREEES
Rermermber password

[ Log on using Secure Password Authentication

Outgeing Mail Server

DM}" server requires authentication Settings...

OK || Canesl Apply

Figure 1 Password Changed Window

3. Click the Servers tab, type your new password in the Password box, and then click
OK.
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To add a Windows Mail account

You can manage different email accounts in Windows Mail or in Outlook Express. It makes easy to
manage mails if you have more than one account and you can use different features that Windows

Mail and Outlook Express offers.

1. Click to open Windows Mail.

Figure 2 Account Add Window - Click Account...

=] Inbox - Windows Mail = = ]
File Edit View JIEEIES Message Help | Search 2|
W Create Mail Send and Receive
4 Local Folders Synchronize All .
» e inbox Windows C Ctrl+ Shift+C
q tacts... 1
& Outbox ndows ontacts st ne iterns may be hidden because a view
=l Sent Item Add Sender to Contacts pplied.
» o Deleted It Windows Calendar Ctrl+Shift+L
47 Drafts
% Junk E-m Message Rules »
Accounts...
Junk E-mail Options... —
¢
Options... 1
Subject:
There is no message selected,
Cenfigures your accounts,
2. Click the Tools menu, and then click Accounts.
3. Click Add, choose the type of account you want to add, click Next, and then follow

the instructions.
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Figure 3 Account Add Window- Type your display name (usually your name)

Your Name

When you send e-mail, your name will appear in the From field of the outgeing message.
Type your name as you would like it to appear.

Display name: hivs arid]

For example: John Smith

Where can I find my e-mail account information?

Figure 4 Choose E-mail Account

Select Account Type

What type of account would you like to add?

| E-mail Account

B Mewsgroup Account

E:I Directory Service
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Figure 5 At E-mail address type your user name which has provided by your System Administrator (RRRSDP
PCU)

=S|

€

Internet E-mail Address

Your e-mail address is the address other people use to send e-mail messages to you,

E-mail address:

For example: someone@microsoft.com

Where can [ find my e-mail account information?

[ MNext ]’ Cancel

Figure 2 Choose POP3 and type rrr.gov.np
Figure 6 For SMTP Server Address: smtp.fol.com.np (For RRRSDP-PCU staff at Ekanakuna, Jawalakhel)
==

€

Set up e-mail servers

Incoming e-mail server type:

POP2 hd

Incoming mail (POP3 or IMAP) server:

FIT.gov.Np

Outgeing e-mail server (SMTP) name:

smtp.Fol.com.npl

[] Outgoing server requires authentication

Where canIfind my e-mail server information?

Mext ]’ Cancel
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Figure 3 At E-mail username: type your full email address like skarki@rrr.gov.np and your password
Attention:

For POP3 it is always same: rrr.gov.np

For SMTP server type your (ISP) Internet Service Provider's domain name (important) l.e. from
where you have taken Internet Service:

For RRRSDP's PCU user at Ekantakuna: smtp.fol.com.np
Enet Fiber Online: smtp.fol.com.np
If account is takes from World link communication: smtp.wlink.com.np

If any confusion contact your ISP or Contact System Engineer Mr. Shiva Karki, RRRSDP-PCU 01-
5536690

Ext. 121, Mob. 9841402099

Figure 7 Give full username and password

Internet Mail Logon
Type the account name and password your Internet service provider has given you.
E-mail username: skarki@rrr.gov.np
Password: sesnsne
Remember password
Mext ] [ Cancel

RRRSDP-Webmail User Guideline-8



Figure 8 At last clink Finish button

Congratulations
¥ou have succrssfully entered all of the informatian required to set up your account.
T'o save Lhese setlings and dewnlead your e-mail, chk Finish,
06 not dewmloed my e-mad at this time
Finezh Caneel |

To remove a Windows Mail account
You can remove any mail account at any time from Windows Mail or Outlook Express. Follow the

steps:

1. Click to open Windows Mail.

2. Click the Tools menu, and then click Accounts.

3. Click the account you want to remove, and then click Remove.

Figure 9 Removing Mail Account Window

Internet Accounts

| Al | M ail | MNews || Directany Sewice| Add »

Azcount Type Connection Remove

rmail [default) A dyailable

i

Properties
Set az Default
Impaort...

Export...

Set Order..

Cloze
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To check for new e-mail automatically

1. Click to open Windows Mail.

2. Click the Tools menu, and then click Options.

3. Click the General tab, and then select the Check for new messages every X minute(s)
check box.

4, To change how often Windows Mail checks for new messages, enter a number

between 1 and 480 in the Check for new messages every X minute(s) box.

Figure 4 To configure auto inform new mails

=il Options L7 =S

General | Read I Receipts I Send I Compose | Signatures I Spelling I Security I Connection I Ad\rancedl

General

[]iNotify me if there are any new newsgroups

[T] Automatically display folders with unread messages

Use newsgroup message rating features

Send / Receive Messages
[¥] Play sound when new messages arrive
[V]5end and receive messages at startup

Check for new messages every 30 = minute(s)

If my coemputer is not connected at this time:

’Do not connect -

Default Messaging Programs

This applicatien is the default Mail handler Malke Default
This applicaticn is the default Mews handler Make Default
oK || Cancel Apply

To check for new e-mail manually

Tips

. To check for new e-mail without sending the mail in your Outbox, click the Tools
menu, point to Send and Receive, and then click Receive All.

. To disable automatic downloading of new e-mail, click the Tools menu, click Options,
and then, on the General tab, clear the Check for new messages every X minute(s)
check box.
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Figure 11 To configure manually for new messages

| Options
General | Read I Receipts I Send I Compose | Signaturss I Spelling I Security | Connection I Mvanced|

General
Motify e if there are any new newsgroups
[] Automatically display folders with unread messages

Use newsgroup message rating features

Send / Receive Messages
Play sound when new messages arrive

Send and receive messages at startup

[CliCheck for new messages eveny 30 ~| minute(s)

If my computer is not connected at this time:

Do not connect

Default Messaging Programs
This application is the default Mail handler Make Default

This application is the default News handler Make Default

ok [ Cancel |[ ooy |
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View e-mail messages in Windows Mail

The simplest way to view an e-mail message in Windows Mail is to read it in the Preview
pane, where you can view the message's contents without opening the message in a
separate window. Or, if you want to see a larger portion of the message without scrolling,
you can open it in a separate window instead.

1. Click to open Windows Mail.
2. Click the mail folder (such as Inbox) that contains the messages you want to read.

Figure 12 To check messages click Inbox or as per your requirement

= Inbox - Windows Mail =N EoR|F5cs)|

Eile Edit View Tools Message Help Search 2|

4 Local Folders ' § % From Subject
’ g;:lgbobx I Microsoft Windows M...  Welcome to Windows Mail
4 : ”tt ;x I Raj Adhikari Re: test
) ': DEeTetleIr::st |l ugautam@rrr.gov.np Re: Thanks
4 Drafts
% Junk E-mail
4 | 1 3

From: ugautam@rrr.gov.np <ugautam@rrr.gov.np>  To: skarki@rrr.gov....
Subject: Re: Thanks

| »

> |
Thanks

Upendra Gautam

3 message(s), 0 unread L. Working Online

3. Do one of the following:

o To view the message in the Preview pane, click the message in the message
list.

o To view the message in a separate window, double-click the message in the
message list.

Viewing folders, messages, and previews in Windows Mail
Tip

. When viewing messages in a separate window, you can click the Previous and Next
buttons to move to the previous or next message.
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Werite an e-mail message

Composing an e-mail message is just like writing a note in a word processor. Once you've
finished composing your message, you type your recipients' e-mail addresses and the
subject of your message in the appropriate boxes, and your message is ready to send.

Keep in mind that you need to create an e-mail account for yourself in Windows Mail to be
able to send e-mail messages.

1. Click to open Windows Mail.

Figure 13 Writing email window: Click File- Click New- Click Mail Message

= Inbox - Windows Mail [ [ =] (]

m Edit View Tools Message Help |Segru:h o
Open Ctrl+0 MNews Message
save As.. Folder.. Ctrl+Shift+E & 1o Windows Mail
Save Attachments...
Save as Stationery... — e
Folder *
Import *
Export »
Print... Ctrl+P | m ] b
ldentities... gautam@rrr.gov.np <ugautam@rrr.govinp>  To: skarki@rrr.gov...

Re: Thanks
Properties Alt+Enter )L
Work Offline =
s
Exit
Upendra Gautam
Creates a new Mail Message.
2. Click the File menu, point to New, and then click Mail Message to open a new
message composition window.
3. In the To: box, type the e-mail address for each of your primary recipients. In the Cc:

box, type the e-mail address for each of the secondary recipients to whom you want
to send a copy of the mail. If you're sending to multiple addresses, separate them
with semicolons.
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Figure 14 Type email address to whom you are sending email at TO: .....and CC: ......for sending
same mail to other accounts also and Subject: Subject of the Mail

L New Message == ]=s

Eile Edit View Inset Format Tools Message Help

;
™ Send Y By B

From: ’skarki@rrr.gov.np (rrr.gov.np) -
To: |
Co |

Subject: |

Jiiil
=
Ty
=
1=
I
-
I
+
L]
=+
L]
[
il
[l
1]

| =&

In the Subject: box, type the subject of your message.
Click in the main message window and type your message.

Once you're satisfied with your message, do one of the following:

o To send the message right away, click the Send button.
o To send the message at a later time, click the File menu, and then click Send
Later.

The message will be sent the next time you click the Send/Receive button.

Tip

If you're writing a lengthy message and want to come back to finish it later, you can

save it at any time. To save a message, click the File menu, and then click Save. Saved

and unsent messages are stored in the Drafts folder

Open or save an attachment in Windows Mail

Using Windows Mail, you can send documents, images, and other files as attachments to

your e-mail messages. Messages that contain attachments are indicated by a paperclip icon

in the Attachment column of the message list. You can open attachments directly from
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Windows Mail, or you can save them to a folder on your computer so you can easily access
them later without needing to locate the message they were attached to.

To open an attachment directly from a message

1. Click to open Windows Mail.

2. Open a message that contains an attachment by double-clicking it in the message
list.

3. At the top of the message window, double-click the file attachment icon in the

message header.

A file attachment icon

To save attachments to a folder on your computer

1. Click to open Windows Mail.

2. Open a message that contains an attachment by double-clicking it in the message
list.

3. In the message window, click the File menu, and then click Save Attachments.

4. Select the folder where you want to save the attachments.

By default, Windows Mail saves attachments in your Documents folder. If you want to save
the attachments to a different folder, click Browse, and then select a folder.

5. Select the attachments that you want to save, and then click Save.
Warning
. Although Windows Mail blocks known dangerous file types, you should still use

caution when opening attachments. To learn more about handling attachments safely, see
Avoiding e-mail viruses.

Block spam and other unwanted e-mail

Windows Mail helps you manage your Inbox to keep it free of unwanted e-mail messages in
the following ways:

. The junk e-mail filter is designed to catch obvious unsolicited commercial e-mail
messages (often called "spam") and move them to a special Junk e-mail folder. You
can increase or decrease the junk e-mail protection level based on how much junk
e-mail you receive.

. You can move e-mail messages from the Junk e-mail folder back to your Inbox.

. You can block messages from specific e-mail addresses by adding them to the
Blocked Senders list.

. You can prevent the blocking of messages from specific e-mail addresses by adding
them to the Safe Senders list.
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Change the junk e-mail protection level

1. Click to open Windows Mail.

2. Click the Tools menu, and then click Junk e-mail Options.
Figure 155 Junk Email Option Window: Choose as per your security requirement

[ =

= Junk E-mail Options =

Options |Saf'e Senders | Blocked Senders | International I Phishing|

= Windows Mail can move messages that appear to be junk e-mail into a special
'.rl" Junk E-mail folder,

Choose the level of junk e-mail protection you want:

) Mo Automatic Filtering. Mail frem blocked senders is still moved to the Junk
E-mail folder,

i@ Low: Move the most obvious junk e-mail to the Junk E-mail folder.

) High: Mast junk e-mail is caught, but some regular mail may be caught as
well. Check your Junk E-mail folder often,

(") Safe List Only: Only mail from people or demains on your Safe Senders List
will be delivered to your Inbozx.,

[] Permanently delete suspected junk e-mail instead of moving it to the Junk
E-mail folder

oK ] [ Cancel Ar

=)
=

3. Select the protection level you want:

o No Automatic Filtering. Click this option if you want to stop blocking junk e-mail
messages altogether. However, Windows Mail will continue to block messages from
domain names and e-mail addresses on your Blocked Senders list.

o Low. Click this option if you don't receive many junk e-mail messages and want to
block only the most obvious junk e-mail messages.

o High. Click this option if you receive a large volume of junk e-mail messages and
want to block as many as possible. However, you should periodically review the
messages in your Junk e-mail folder to ensure that there are not any legitimate
e-mail messages that might have been moved there as well.
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o Safe List Only. Click this option if you only want to receive messages from people or
domain names on your Safe Senders list. E-mail messages from people or domain
names not on your Safe Senders list will be treated as junk e-mail messages, so you
should only choose this option if you are certain that every person or domain name
you want to receive messages from is on your Safe Senders list.

Move a message from the Junk e-mail folder to your Inbox
1. Click to open Windows Mail.

2. Click the Junk e-mail folder.

= Junk E-mail - Windows Mail
Eile Edit Wiew Tools Message Help

' Create Mail - ﬂ Reply [ ] Reply All '_‘ Forward !;!

4 Local Folders [

¥ From

® <] Shiva d

- & Inbox
& Outbox

7 Sent Items
Deleted Items
| Drafts

Junk E-mail

@%H’l

4 | 1 | 3

From: Shiva <skarki@rrr.gov.anp= Toe info@rrr.gov.np <info@rrr.gov.np=

Subject: d
df
1 rnessage(s), 0 unread B Working Online
3. Click the message that you want to move to your Inbox.
4. Click the Message menu, point to Junk e-mail, and then click Mark as Not Junk. The

message is moved to your Inbox.

Note
o Though marking a message as not junk will move that message to your Inbox, future

messages from that sender might still end up in the Junk e-mail folder. To prevent
this from happening, add the sender to the Safe Senders list.
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Add a sender to the Blocked Senders list

When a message is received from an e-mail address that's on the Blocked Senders list, it is
automatically moved to the Junk e-mail folder. The only exception is if the address is also on
the Safe Senders list, in which case the message won't be filed as junk because the Safe
Senders list has priority over the Blocked Senders list.

1. Click to open Windows Mail.

2. Click a message from the sender that you want to add to the Blocked Senders list.

3. Click the Message menu, point to Junk e-mail, and then do one of the following:

o To block all future messages from that specific sender, click Add Sender to Blocked

Senders List.

o To block all messages from any sender whose domain name (the portion of the
e-mail address after the @) is the same as the sender's, click Add Sender's Domain
(@example.com) to Blocked Senders List.

Note

o If you want to add a sender to the Blocked Senders list and you don't have a message
from that sender available, you can add the sender's address manually. To do this,
click the Message menu, point to Junk e-mail, and then click Junk e-mail Options.
Click the Blocked Senders tab, click Add, type the e-mail address you'd like to block,
and then click OK.

Add a sender to the Safe Senders list

When a message is received from an e-mail address that's on the Safe Senders list, it won't
be moved to the Junk e-mail folder.

1. Click to open Windows Mail.

2. Click a message from the sender that you want to add to the Safe Senders list.

3. Click the Message menu, point to Junk e-mail, and then do one of the following:

o To allow all future messages from that specific sender, click Add Sender to Safe

Senders List.

o To allow all messages from any sender whose domain name is the same as the
sender's, click Add Sender's Domain (@example.com) to Safe Senders List.

Note

o If you want to add a sender to the Safe Senders list and you don't have a message
from that sender available, you can add the sender's address manually. To do this,
click the Message menu, point to Junk e-mail, and then click Junk e-mail Options.
Click the Safe Senders tab, click Add, type the e-mail address you'd like to allow, and
then click OK.
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Import messages to Windows Mail from other e-mail programs

You can switch to Windows Mail from your existing e-mail program without losing access to
your existing e-mail messages. Windows Mail can import messages from a variety of popular
e-mail programs, such as Eudora and Netscape Communicator, as well as from Microsoft
Exchange and Microsoft Outlook.

1. Click to open Windows Mail.

Figure 17 Import Mail Messages from Other email programs windows (Choose as per your
requirement)

Windows Mail Import
Select Program

Select the format you want to import e-mail from.

Microsoft Qutlook
Microsoft Outlook Express 6
Microsoft Windows Mail 7

< Back Mead = ] [ Cancel

2. Click the File menu, point to Import, and then click Messages.

3. Follow the instructions to import your e-mail messages.

Notes

. If you are upgrading your computer from a previous version of Windows, keep in
mind that Windows Mail will automatically import messages from Outlook Express.
Windows Mail replaces Outlook Express in this version of Windows.

. When you import messages, Windows Mail does not import account settings. To
import e-mail account settings, click the File menu, click Accounts, and then click
Import.
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Add, delete, or rename e-mail folders

Using folders, you can categorize and organize your e-mail messages for easy access later.
For example, you might create a folder called "Work" for job-related e-mails, and another
called "Family" to hold conversations with relatives. You can manually drag messages into
folders, or use rules to automatically move messages containing particular senders or

subjects to appropriate folders.

= Inbox - Windows Mail
mEdit View Tools Message Help

Mew
Open

Save As...

Save Attachments...

Save as Staticnery...

Folder

Import
Export

Print...
Identities...
Properties

Work Offline
Exit

(=G ]
Search 2|
Mail Message
Ctrl+ O Mews Message
Folder... Ctrl+5Shift+E & t0 Windows Mail
Contact...
. i I-fs
Ctrl+P m b
gautam@rrr.gov.np <ugautam@rrr.gov.np>  To: skarki@rrr.gov....,
: Re: Thanks
Alt+Enter i
E
5
Upendra Gautam

To add an e-mail folder

1.

2.

Click to open Windows Mail.

Type the name of your folder in the Folder name box.
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Figure 19 Create Folder Window: Choose as per your requirement

F =

Create Folder =
Folder name: 0K
Select the folder in which to create the new folder:
4 Local Folders
# Inbox
& Outhox
1 Sent Itermns
o Deleted Items
2 Drafts
5 Junk E-mail
3. In the Select the folder in which to create the new folder list, click the folder where

you want to store your new folder.

To delete an e-mail folder

1. Click to open Windows Mail.
2. In the Folders list, click the folder you want to delete.
3. Click the File menu, point to Folder, and then click Delete.

To rename an e-mail folder

1. Click to open Windows Mail.

2. In the Folders list, click the folder you want to rename.

3. Click the File menu, point to Folder, and then click Rename.
4. Type the new name for the folder in the Folder Name box.
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Quick Tips for Web Mail Users

1. Be sensitive and kind hearted when composing an e-mail message. It is not only the
nice thing to do, it is the safe thing to do ... e-mail messages are easily forwarded ...
unkind words and off colored language or stories included in an e-mail can come
back to haunt you. Carefully select the font style you use ... for example all capital
letters might be interpreted as yelling at someone.

2. Avoid using a Web Page-HTML e-mail format. If your e-mails look like a web page
they will be sent as HTML format and unless the receiving party is using the same
format they will have trouble reading your message. It is best to send messages
using a "simple plain text" format. To find and select the simple plain text format
look in the drop down menus...for MS-Outlook select: Tools-Options-Mail Format-
Message Format then select Plain Text (this is also important for avoiding the
sending of winmail.dat attachments).

3. Include a title for the message in the subject area. The people you send messages to
should be taught the principle to not open any e-mail message that does not have a
subject. If you don't open what you don't know about you (your computer) will be
less likely to get infected ...

4. Always include a signature at the end of your e-mail. Most e-mail software will allow
a "signature" to be automatically included added. The signature should include your
name, city and state. It maybe useful to include a complete address, phone, and e-
mail address.

5. Attachments sent in a personal e-mail should be small. Regardless of the speed of
your modem, most domestic phone lines will only carry 4K per second ...240K per
minute (sometimes not that fast). Keeping the files you attach as small as possible
will avoid downloading problems for the recipient of your attachment. Converting
graphic/pictures to the JPG format will greatly reduce their size. If you have multiple
files to send consider "zipping" them before sending. WinZip software for Windows
can be found at http://www.winzip.com.

6. Attachments sent in a personal e-mail should include the name of the attachment in
the body of your e-mail message. Unless you are certain of the software available to
the recipients of your attachment, convert the file to the most widely accepted
formats. Sending a file in TXT (Text) or RTF (Rich Text Format) will almost always
open on any other computer you send it to. Each program has a different way of
allowing you to save your files, choosing to save the file as Text Only or Rich Text
Format increases the likelihood that the recipient will be able to open the file. Be
sure and provide a filename extension to your files so that all recipient systems will
know what program to use to open them:

Extension Format
Xls, xlsx Microsoft Excel (Microsoft Office 2007)
.doc, .docx Microsoft Word (Microsoft Office 2007)
.ppt, .pptx |Microsoft PowerPoint Presentation(Microsoft Office 2007)
.pps Microsoft PowerPoint Show
Ixt Text (ASCII, Text Only)
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rtf Rich Text Format (some formatting retained)
.Zip ZIP file (compressed, archived)

Attachments should not contain the following characters. They are generally
reserved for the operating systems to distinguish between directories, or are
considered dangerous in an attachment name:

\/:*¥?2"><|

Slashes, colons, asterisks, question marks, quotes, greater/less than, pipe

Foreign characters, non-English, can sometimes cause problems as well.

8.

Do not send an executable to any Farmington Municipal Schools account. Our server
is set, as many on the internet are, to reject all executable files. On your personal
computer at home never open an attachment that has an "EXE" extension unless you
are extremely comfortable with the safety of the source. Computer viruses and
computer worms often arrive at your computer as files ending with an "EXE"
extension. Be very cautious of any file you receive you are not expecting. Deleting
them without opening is the safest way to avoid infecting your computer. Many of
the nasty infections your computer can get come from MACROS therefore make sure
the MACRO VIRUS PROTECTION option is selected in your spread sheet set-up. For
Excel it is found in options under the tools menu.

How to read email; and write email that people will read

Email is fundamentally a form of communication; it is about communicating thoughts and
ideas. If you are not getting your message across then it is not succeeding. Unfortunately,
there are a lot of things that people commonly do that make email hard (or boring) to read
and hamper communication. If you want to write effective email, this document contains
some rules and guidelines which can help. Similarly, there are hints on receiving and reading
email so that you and your computer do not get burnt.

There are references for further reading at the end. These are strongly recommended.

Privacy/Security

Email is neither private nor secure. Although email is a very useful tool, email messages
must be treated with caution.

Consider carefully what you write; it is a permanent record and can be easily
forwarded to others or intercepted on the way.

Be careful about what you read; email forgery is trivially easy. Apply common sense
"reality checks" before assuming a message is valid.

Don't assume that email is instant. Technical reasons may delay delivery or people
may not be reading email at the time. If the matter is urgent, follow it up with a
phone-call or a door-knock.

Never open an attachment unless you know what it is and you are expecting it.
Attachments are a major source of computer viruses and other nasty stuff.

Don't forward virus warnings. In most cases these are hoaxes or old news that only
annoy others. If in doubt, talk to your system administrator.
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Politeness

Email combines the worst features of written communication (in that you have none of the
visual clues such as a smile) and of personal conversation (in that you can respond
immediately without time for reflection). In the absence of other helpful clues, it is very
easy to take offence. Courtesy is all that keeps it usable.

Email should never contain material which might cause offence (racist, sexist, etc).
Such material will usually lead to your email access being terminated; and is a
permanent record which can be used in criminal prosecution.

Flaming (sending strongly emotional email) is rarely appropriate. It is like throwing a
tantrum and is unlikely to encourage a positive response.

Responding to heated email should be done cautiously if at all; waiting till the next day
is often wise. It is sometimes useful to write the response you would like to send, then
delete it and craft a more carefully worded reply.

Flame wars easily get out of hand. A phone-call or a door-knock is often useful to
stabilise an over-heated situation and to deal with things productively. If someone is
really steamed up, there are probably other issues that need dealing with.

Flaming in a public forum is never appropriate; it looks childish and will annoy most
people.

If you are flamed in an public forum it is generally wise not to respond (it is the flamer
that looks silly).

Use emoticons (smileys) if necessary to convey a tone of voice. ":-)" indicates that | am

happy and smiling as | type; ";-)" and | am just kidding.

Use emoticons sparingly: more than a couple in a message look tacky; they are never
appropriate in formal or professional communication.

Don't assume that including a smiley will make the recipient happy with what you say
or wipe out an otherwise insulting comment.

Check all your incoming email before responding to a message. There may well be
further information that changes things considerably.

Re-read your messages at least twice before you send them; catching simple smelling
errors and making sure the "tone" of the message is appropriate.

DO NOT TYPE IN ALL UPPER-CASE. IT IS LIKE SHOUTING AND IS RUDE AND IS HARD TO
UNDERSTAND.

Don't send attachments that your readers cannot read. For example, a Word
document will not be readable by most people in our School. If in doubt, talk to the
intended reader about what formats they can handle.

Distribution

Sending unsolicited email (especially any advertising) is known as spam. It annoys most
people and obscures important messages.

Target your address list carefully. Too broad a distribution is a form of spamming and
will simply annoy most people who receive it.

When replying, check (and usually trim) the list of recipients. Don't reply to a list
unless you are sure that your reply is relevant to the whole list.

Never send chain letters via email.
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Content/Style

The point of any form of communication is to communicate. If you want to get your
message across:

e Write succinctly, keep messages short and to the point; anything beyond the first
screenful is unlikely to be read.

e Use descriptive subject lines. Many busy people will only open messages with
captivating subject lines. Think creatively.

¢ Focus on one subject per message, that way the reader can locate the message
easily and deal with it appropriately.

¢ Use quoted material to give context when replying. A simple reply of "yes" may not
be meaningful when read several days later.

¢ Do not over-quote. Omit whatever is not required to understand your reply. A
couple of sentences is usually enough. If necessary, paraphrase the original email;
indicating that it is a paraphrase (usually with "[1").

o |Ifitis necessary to include a lengthy quote, put your response before the quote (or it
will not be noticed).

e If you include a "signature" (contact information, like a business card), keep it short
and pertinent.

Format/Compatibility

If you want to communicate, it is useful to use the same language. There are many different
mail programs (such as pine or outlook) running on a number of different platforms (such as
Macintoshes or Unix computers). Messages do not necessarily translate well between
different programs or platforms. If any of your readers use a computer or email program
different from your own, the following points will be useful.

e Limit your text to "typewriter" characters (letters, numbers, basic punctuation).
Copyright signs and even some punctuation marks may be unreadable for other
people. Colours, bold and italics should be avoided.

e Asterisks can be used to make a *stronger* point. The underscore character can
indicate _underlined_ text.

Attachments

Compatibility issues apply as much to attachments as to messages. In general, the larger and
more diverse the list of recipients, the more care needs to be taken with the format of any
data that is sent.

¢ Never open an attachment unless you know what it is and you are expecting it.

¢ Be cautious about sending attachments; not all mail reading programs can handle
them.

¢ Do not send large attachments to a large group of people. The sheer volume entailed
in many copies of a large item can overwhelm mail systems. Consider sending a URL
or some other reference instead.

e Be cautious about sending application-specific data. For example, a Word document
may not be readable by most people in the School. If in doubt, talk to the intended
reader about what formats they can handle.

e Be cautious about encoding formats. Refer to the information about attachments

above.
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Properties of Good Password:

Good passwords have at least some of the following characteristics:
All passwords are to be treated as sensitive, confidential personal information.

e They are at least 8 characters long. Generally the longer the password the harder it is to
break. Good passwords should be a mix of both alpha and numeric characters.

e No words listed in any dictionary should be used. Hackers love this and even a PC can
try thousands of dictionary words in seconds.

e Passwords should be easy to remember so you don’t have to write them down.

Good passwords have the following characteristics:

e Contain both upper and lower case characters (e.g., a-z, A-Z)

e Have digits and punctuation characters as well as letters e.g., 0-9,
o 1@#S%N&*()_+|~- =\'{}]:";'<>?,./)

e Are at least eight alphanumeric characters long.

e Are not a word in any language, slang, dialect, jargon, etc.

e Are not based on personal information, names of family, etc.

List of Don’t for Passwords:

e Don't reveal a password over the phone to ANYONE.

e Don't reveal a password in an email message.

e Don't talk about a password in front of others.

e Don’t hint at the format of a password (e.g., “my family name”)

e Don’t reveal a password on questionnaires or security forms.

e Don’t share a password with family members.

e Don’t reveal a password to co-workers while on vacation.

e Don’t use the “Remember Password” feature of applications (e.g. Eudora, Outlook,
Netscape Messenger,

Bad Password Characteristic:

Poor, weak passwords have the following characteristics:

The Password contains less than eight characters

The password is a word fond in a dictionary (English or foreign)

The password is a common usage word Such as:

Names of family, pets, friends, co-workers, fantasy, character, etc.

Computer terms and names, commands, sites, companies, hardware, software.
Birthdays and other personal information such as addresses and phone numbers.
Word or number patterns like aaabbb, qwerty, zywwvuts, 123321 etc.

Any of the above spelled backwards.

Any of the above preceded or followed by a digit (e.g., secret 1, 1 secret)

Good examples:

Ona327(sA

@865Daozk

93Sowt#-aq
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Folder Preferences:

These settings change the way your folders are displayed and manipulated:

Users may define:

(1) Trash Folder — This is primarily meant for the saving of the trash messages which
your may later delete by clicking on purge messages.
(2) Draft Folder: This is for the draft folder, if any messages are left half composed or

you want to compose it later after thinking a while or your may want to send the
message later (Many reasons here also!), meanwhile if your save your messages
then it will go in this folder.
(3) Sent Folder: Specified Sent Folder will store all the messages which are sent by you
to different users. You may also create new folder and make it as Sent Folder.
(4) Other Options are:
(a) Show Some Folder as collapsed
(b) Show Folder Sizes as
As link under folder list
On Folder Page
With subtotals
(5) Sent Subfolders Option:
Use Sent Subfolders:
Base Sent Folder:

Using Templates:

Create/Edit/Delete chunks of text that can be quickly added to messages.

You can store messages as templates which your can utilize for adding the standard messages
immediately to your mail. Ed. formats which are used frequently like Joining Report, Leave
Report and Other frequently filled reports.

Below are the locations where templates may be appended:

(a) Append Templates before all existing text.
(b) Add blank line before template text when appending.
(c) Add blank line after template text when appending.

Templates are very handy if already if they are already created for day to day purposes:

Display Preferences:

You can change the way that Webmail looks and displays information to you, such as the colors,
the language, and other settings.
It helps in flowing ways:
1. It helps in distinguish the IMPORTANT information from the other non important ones.
2. It helps in distinguish the IMPORTANT mails from the other non important ones.
3. Visual Impact and Colorful appearance gives the good feeling, with full customization.

*Thanks for reading*
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